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About this Manual

The VISE

Principle ATLAS.ti - The Knowledge Workbench Main Steps in Working with ATLAS.ti

Main Steps in Working with ATLAS.ti

Starting ATLAS.ti

The ATLAS.ti Interface

Adding Documents

Project Management

Entity Managers

Exploring Data 

Working With Quotations 

Coding Data

Auto-coding Data

Working With Comments And Memos

Working With Groups

Working With Hyperlinks

Querying Data

Working With Networks

Useful Resources



Video tutorial: What's New in ATLAS.it 22

How to Use this Manual

Useful Resources for Getting Started

https://training.atlasti.com

https://youtu.be/wAXfLsnKO-g
https://training.atlasti.com/


ATLAS.ti Account and Licence Activation

Multi-User License Management Guide for License

Holders & Administrators

Requesting a Trial Version

Trial Desktop

My Applications

Activating a Licence

https://atlasti.com/institutions/atlas-ti-license-management/
https://atlasti.com/institutions/atlas-ti-license-management/
https://atlasti.com/institutions/atlas-ti-license-management/
https://atlasti.com/institutions/atlas-ti-license-management/


Activate License.

Check For Updated License

Accessing Your Account from within ATLAS.ti



Manage Account



Logging Out

Log Out and Restart

https://my.atlasti.com/

Log Out

Working Off-Line

off-line

Options



Limited Version after Licence Expiration

Restrictions of the Limited Version





Introduction

Video Tutorial: Overview of ATLAS.ti 22 Windows

The VISE Principle

VISE

Visualization

https://youtu.be/NIO4Kca_l-4


Immersion

Serendipity

a seeming gift for making fortunate discoveries

accidentally

serendipity

browsing



Exploration

bureaucratic

Areas of Application

soft data



contextuality



ATLAS.ti - The Knowledge Workbench

knowledge workbench

Some Basic Terms

container

ATLAS.ti project

source data

copied

Project Cloud

text documents

images audio recordings

video clips PDF files

geo data

social network comments

coding

codes

marking annotating

paper and pencil paradigm



margin area

General Steps when Working with ATLAS.ti

Creating a New Project

Adding Documents

Working With Groups

Working With Comments And Memos Coding Data - Basic Concepts

Retrieving Coded Data

Data Analysis Data

Export For Further Statistical Analysis

Working With Networks

Working With

Comments And Memos Exporting Networks

The ATLAS.ti Research Blog The

ATLAS.ti conference proceedings

https://atlasti.com/research-hub
https://depositonce.tu-berlin.de/bitstream/11303/5404/3/ATLASti_proceedings_2015.pdf
https://depositonce.tu-berlin.de/bitstream/11303/5404/3/ATLASti_proceedings_2015.pdf


Main Concepts and Features

Documents

Document Groups

Quotations

Codes

Memos

Comments

Groups

Networks

Data Exploration

Analysis

Team Tools

Report

Data Export



Documents and Document Groups

Documents

Supported file formats

Document groups

Working with Groups

Code Document Table



Quotations

Search & Code tools

Working with Quotations the ATLAS.ti Quotation Level



Codes

code

Coding means that we attach labels to data segments that depict what each segment is

about. Through coding, we raise analytic questions about our data from […]. Coding distills

data, sorts them, and gives us an analytic handle for making comparisons with other

segments of data.

Coding is the strategy that moves data from diffuse and messy text to organized ideas about

what is going on.

From a Methodological Perspective



From a Technical Perspective

Coding Data Working With Codes.

References



Memos

Memos [...] are working and living documents. When an analyst sits down to write a memo or

do a diagram, a certain degree of analysis occurs. The very act of writing memos and doing

diagrams forces the analyst to think about the data. And it is in thinking that analysis occurs

Writing is thinking. It is natural to believe that you need to be clear in your mind what you are

trying to express first before you can write it down. However, most of the time, the opposite

is true. You may think you have a clear idea, but it is only when you write it down that you

can be certain that you do (or sadly, sometimes, that you do not)



stand alone

Working with Comments and Memos

References





Comments

Working with Memos and Comments



Groups

Document groups can be regarded as attributes or variables

Code groups serve as a filter for codes

Building a Code System

Working with Group



Networks

Nodes, Links and Relations

node

link

Relations



Network Manager

Network

Manager

Network Editor

Link Manager

Link Manager

Relation Manager

Creating New Relations

Working with Networks



Tools for Exploring Text Data

Word clouds word lists Creating Word

Clouds Creating Word Lists

Search & Code Tools

Text search

Text Search

Expert search

Expert Search

Named Entity Recognition (NER)

Named Entity Recognition

Sentiment Analysis

Sentiment Analysis



Analysis

Cross-Tabulation of Codes (Code Co-occurrence)

Code Co-Occurrence

Tools.

Code-Document Table

Code Document Table

Query Tool

The Query Tool

Global Filters

Applying Global Filter

Smart Codes

Working With Smart Codes



Smart Groups

Working With Smart Codes



Project Cloud

privacy policy

Your project will

stay safely on your computer until you decide otherwise.

https://atlasti.com/legal/privacy-policy


On this computer

In the cloud

Both on this computer and in the cloud

How to use



Sharing Projects

Team Work

Current limitations



Team Tools

Team Work

ATLAS.ti Web version

Project Cloud (Beta)

Project Cloud

Project Merge

Merging Projects.

Clean up Redundant Codings

Codings Analyzer

Finding Redundant Codings.

Coder Icons in the Margin Area

https://atlasti.com/cloud/


Inter-Coder Agreement

Inter-coder Agreement.

User Administration

User Accounts

synchronous

ATLAS.ti Web

https://atlasti.com/cloud/


Export

Word / PDF

Documents quotations codes

memos

Creating Reports

Excel Export

Code Co-occurrence Table Code Document Table

Creating Excel Reports

Print Documents with Margin

Print with Margin

QDPX Exchange Format For Projects

https://www.qdasoftware.org QDPX Universal Data

Exchange

SPSS / PSPP Export

SPSS Export

Code Document Table

https://www.qdasoftware.org/


Generic Statistic Export for R, SAS, STATA, etc.

Generic Export For Further Statistical Analysis

Image Files

Exporting

Networks

Word Clouds Word Clouds and Word Lists

Visualization of the Code Co-occurrence Table

Visualization of the Code Document Table



Main Steps in Working with ATLAS.ti

Data and Project Management

Supported File Formats

Project Management

Team Work

Two Principal Modes of Working



Data Level Work

Exploring Data

quotations

note-making/annotating hyperlinking

search retrieval, and browsing functions

Conceptual Level Work



Querying Data Working With Networks



Welcome Screen

Welcome Screen (left-hand side)

licence information create a new project import an

existing project Options

Welcome Screen (middle section)

search field

sort

Project Cloud



Context menu for projects

hide

Show all

projects

open a project pin it to the

favorite list rename a project delete a project

project bundle

file

Welcome Screen (right-hand side)

News

Resources

Video Tutorial



Creating a New Project

Video Tutorial: Creating a project and adding data

Create New Project

https://youtu.be/ikoGSmpkb4I




Create

File > New Create New

Project

Create



Importing an Existing Project

How to Import Projects

Import Project

File > New Import Project

Options



If the project contains Linked Media Files



Project File Formats



The ATLAS.ti Interface

The ATLAS.ti Ribbon



Home

Search & Code

search expressions

identify entities

positive, negative, or neutral sentiments

identify concepts

AI Coding

word cloud word lists

Analyze

Querying Data.

Import & Export



Support File Types.

Working with Reference Manager Data.

Working with Survey Data.

Social Network Comments

Importing

and Exporting Code Lists Importing and Exporting Document Groups.

Data Export for Further Statistical Analysis.

Tools User Management

Finding Redundant Codings

Help

File Menu / Backstage

File

Project Management.





Software Navigation

Children & Happiness sample project

Importing An Existing Project .

Entity Managers.

https://atlasti.com/sample-projects


Documents

Codes

Basic concepts

Memos

Networks

Groups



Browsers

Navigator





Context Menus





Working with Docked and Floated Windows

Codes

Float

Always On Top

Always On Top



Working With Tabs and Tab Groups

New Tab Group > Right





The Six Main Entity Types

Documents

Quotations

Codes

Memos

Networks

Links

Entity Managers Entity Managers

child

Miscellaneous Goodies



Entity Managers

Entity Managers

Launching an Entity Manager

Documents Home tab

Software

Navigation

View tab,

View Options

The Split Bar



The Status Bar

Selecting Items in an Entity Manager

single click

Double-clicking

multiple selections

Searching



Incremental Search:

Context Menus

Sorting and Filtering

Simple Boolean

Queries in the Quotation Manager

View Search & Filter

Tools

View Options



Detail Single Column

cloud bar chart

Code Manager

Search & Filter Options

Regular Expressions (GREP).

global filters



The Document Manager

Search & Code

focus group coding tool

word clouds word lists

concepts

AI Coding

geo locations in Google Maps.

Status Bar:



ID

Name:

Location:

Adding Documents

Code Distribution across Documents

Filter

Applying Global Filters For Data Analysis

The Document Manager Ribbon

Add Document(s): Adding Documents

New Group: Working With Groups

New Smart Group:

Working With Smart Groups

Search & Code:

Search & Code

Focus Group Coding: Focus

Group Coding

Rename:



Delete:

Edit Comment:

Working With Comments And Memos

Open Group Manager: Working With Groups

Open Network:

Analytic Functions in Networks

Word Cloud:

Creating

Word Clouds

Word List:

Word Lists

Concepts:

Find Concepts

AI Coding: AI Coding

Report / Excel Export:

Creating Reports

Tools Tab

Renumber Documents:



Managing Documents

Renumber Quotations:

when

Renumber Quotations

Import Transcript:

Importing

Multimedia Transcripts

Document Export:

Repair Link:

Remove Codings:

Browse Geo Location;

Working With Geo Docs

Duplicate document(s):

Search & Filter / View Tab

Entity Manager



Quotation Manager

Working with Quotations

Quotation Reference

ID:

Reference:

Indicator of Hyperlinks:

Working with Hyperlinks



Position in the Document: Start / End / Extent

Start / End

Text quotation:

Graphic quotation:

Audio quotation:

Video quotation:

Geo quotation:

Extent

Geo quotation:

Adding Quotation Names

Name:

Working with Quotations

Selection Behaviour

A single-click

A double-click

Multiple Selection:

Drag & Drop

Working with

Hyperlinks



Filter

Status Bar:

Quotation Manager Ribbon

Smart code:

Working with Smart Codes.

Code in Vivo:

Apply Coding: Coding Data.

Quick Coding:

Rename Quotation:

Delete:



Edit Comment:

Working With Comments and Memos.

Merge Quotations:

Renumber Quotations:

Link Source:

Creating Hyperlinks.

Link Target:

Creating Hyperlinks.

Open Network: Opening an ad-hoc

Network.

Word Cloud:

Creating Word Clouds.

Word List:

Word Lists.

Report / Excel Export:

Creating Reports.

Search & Filter / View Tab

Entity Manager



Code Manager

Code

Distribution Over Documents

Diagram Preview Comment

Good to know

Groundedness:



Density: Linking Nodes

Colors:

Working with

Networks

Selection behaviour

A double click Quotation Reader

Single-click:

Multiple Selection:

Drag & Drop

Filter

Applying Global Filters for Data Analysis

Status Bar:



Code Manager Ribbon

New

Code:

Folder:

New Folder from Selection:

Smart Code:

Working with Smart Codes 

Create Snapshot:

Creating Snapshot Codes

Group:

Smart Group:

Working with Smart Groups

Edit Comment

Working with

Comments and Memos

Color

Show in Network

Opening ad-hoc

Networks



Global Filter

Rename

Delete

Analyze

Show Co-occurrences Between Selected Codes:

Show Co-occurrences:

Show Code-Document Analysis:

Text Search:

Regular Expression Search:

Named Entity Recognition:

Sentiment Analysis:

Concepts:

Find Concepts

Opinion Mining:

Word Frequencies:

Creating Word Clouds

Word Lists

AI Summaries:

Tools

Duplicate Code(s):

Working

with Codes



Merge Codes:

Merging

Codes

Merge

Split Code:

Splitting a Code

Split into Subcodes:

Edit Smart Code:

Working with Smart Codes 

Find Redundant Codings:

Finding Redundant

Codings 

Import Codebook:

Importing & Exporting

Code Lists QDPX Universal Data Exchange

Export

Report / Excel Export:

Creating Reports

Export Codebook:

Importing & Exporting

Code Lists QDPX Universal Data Exchange

Filter

Entity Managers

Code Groups

Working with Groups



View

Code List as Cloud

Cloud



Code List as Bar Chart

Bar Chart



Code List as Treemap

Treemap



Relation Manager

Working With Networks

Links Home

Usage:

Style:

Layout:

Short:



Symbol:

Formal Property: About Relations

Relation Manager Ribbon

New Relation:

Duplicate Relation(s):

Rename Relation:

Delete Relation(s):

Line Color:

Line Width:

Line Style:

Layout Direction:

Formal Property:

About Relation

Filter:

Excel Export:

View Tab

Entity Manager



Link Manager

Link Manager Columns for Code-Code Links

Source:

Relation:

Working with Networks

Target

Created by:

Modified by:

Created / Modified:



Link Manager Columns for Hyperlinks

Source:

Relation: Working with Hyperlinks

Target

Created By:

Modified By:

Created / Modified:



Link Manager Ribbon

Cut Link(s):

Flip Link(s):

Change Relation:

Edit Comment:

Open Relation Manager;

Creating New Relations

Filter:

Open Network: Open ad-hoc Network

Excel Export:

View Tab

Entity Manager



Memo Manager

Groundedness:

Density:

Double-click

Ctr + Double-click

Drag & Drop



Filter

Status Bar:

Memo Manager Ribbon

Create Free Memo:

New Group:

Create Smart Group:

Working with Smart Groups

Duplicate Memo(s):

Convert to Document:

Edit Memo:

Rename Memo:

Delete Memo(s):

Edit Comment:

Working With Comments And Memos

Set Type:

Open Group Manager: Working With Groups



Open Network:

Opening an ad hoc Network

Report / Excel Export:

Creating Reports

Search & Filter / View Tab

Entity Manager



Network Manager

Degree:

Double-click

Drag & Drop:

Filter:

Status Bar:



Network Manager Ribbon

Create Network:

New Group:

New Smart Group:

Duplicate:

Rename Network:

Delete:

Edit Comment:

Open Group Manager:

Show in Network:

Excel Export:

Search & Filter / View Tab

Entity Manager



Supported File Formats

Textual Documents

Format File Type

Multimedia Transcripts

Transcripts

Transcription

PDF files (Text and Graphic)



PDF with annotations / Word files with comments

Imported comments

Imported annotations

PDF documents with annotations imported in ATLAS.ti



Word document with comments

Immporting a codebook



PDF files with bookmarks



View Show

Bookmarks

PDF files (eBooks, PowerPoint, Spreadsheets, Visio, Draw)



Images

Size recommendation:

Audio- and Video Documents

available here

Adding Documents

Geo Documents

Query Address

Working With Geo Docs

Social Network Comments

exportcomments.com

https://msdn.microsoft.com/en-us/library/windows/desktop/dd757927(v=vs.85).aspx
https://exportcomments.com/


Importing Social Network Data

Survey Data

Working With Survey Data

Reference Manager Data

Literature Review

Working With Reference Manager Data.

Evernote

Bring out the best in Evernote with ATLAS.ti Windows

Evernote Export File Type

https://atlasti.com/research-hub/evernote-with-atlas-ti-windows


Adding Documents

Video Tutorial: Creating a project and adding data

What happens when you add documents to a project

add

When you add documents to a project, they are stamped with a unique ID.

Important for team projects

all entities are stamped with a unique ID when they are created.

merge duplicated codes

Team Work

How to add documents

Add Documents Home

https://youtu.be/ikoGSmpkb4I


Linking video files

Repair Link

Document Manager > Tools Tab

import iranscripts Importing Transcripts

prepare your own transcripts



Sort Order of Documents

User-defined document sort order

Size Restrictions

A Word about "Big Data"



Transcription

prepare your own transcripts import transcripts



Supported timestamps for TXT, RTF, and DOCX transcripts

Format Exported by



Importing Transcripts

multimedia transcript in ATLAS.ti

Add Documents Import Transcript



Import

Working with Multimedia Transcripts



Preparing your Own Transcript

multimedia transcript in ATLAS.ti

Step 1 - Add an Audio or Video File

Add Documents

Add Documents >

Add Linked Video/Audio

Add a multimedia file

Step 2 - Create a Word file

Step 3 - Associate the Word File

Tools

Import Transcript.

Step 4 - Begin to transcribe

Edit

Pause



Save



Working with Multimedia Transcripts

multimedia transcript

Opening Transcripts

Multimedia Transcripts

Synchronized Scrolling

synchronized scrolling

Timestamp List

Editing Timestamps

Edit Timestamps



Moving a Timestamp

Adding a Timestamp

Add Timestamp.

Deleting a Timestamp

Delete.

Deleting an Association

Disconnect.



Working With Reference Manager Data

On Conducting a Literature Review with ATLAS.ti

Managing Literature Reviews Using ATLAS.ti

video tutorial Literature Review with ATLAS.ti 22 Windows & Mac

Importing Reference Manager Data

Import & Export

Reference Manager

https://atlasti.com/research-hub/using-atlas-ti-8-windows-in-literature-reviews
https://www.slideshare.net/AniMunirah/dsg-1st-meetup-literature-reviews-using-atlasti
https://www.youtube.com/watch?v=weErZGkPeTo




Document name format

(recommended)

If the full document is not available

Inspecting the Imported Documents



Importing Social Network Comments

Video Tutorial: Importing social network comment

exportcomments.com

exportcomments.com

Import & Export Social

Network Comments

exportcomments.com Open

https://youtu.be/Qwx1ZkYO1BQ
https://exportcomments.com/
https://exportcomments.com/


sentiment analysis





Importing data from Evernote

Import & Export Evernote

Evernote





Working With Survey Data

Video Tutorial: Importing Survey Data

Survey Concept ATLAS.ti Concept

https://youtu.be/jiX6Ubmrcn4


'Question 1::Tell me about the highlights of your last vacation'.

Data are imported case-based.

Import Survey Data



Importing Survey Data

Import & Export Survey

Open

Undefined:

Ignored:

Document Attribute: name:



Body row

Document Attribute: comment:

Document Group: single-answer question:

Document Group: multiple-answer question

Coded document content: open-ended question:

Toolbar

Header Rows





Inspecting Imported Survey Data

Document names

Document groups



Data

AI Coding sentiment analysis letting ATLAS.ti look

for concepts

Code Document table





Analyzing Survey Data

Working With Codes

Exploring

Data Search & Code

Code-Document Table

Query Tool

Code Co-occurrence Table



Adding a Geo Document to a Project

Street Map Bing Map / Big Satellite Map

Add

Documents button New Geo

Document.

Finding a Location

Query Address.



Changing the View from Open Street Map to Bing

Tools Map Type

Working with Geo Data



Working with Geo Documents

Change Map Type

Creating Geo Quotations

Quotation Level Working with

Quotations

Create Free Quotation

Create Free Quotation

Create Free Quotation

Display of Geo Quotations



Working with Multimedia Quotations

Activating Geo Quotations

Modifying a Geo quotation



Coding Geo Quotations

Coding Data

Apply Codes

Creating a Geo Snapshot

Snapshot

Creating Image Quotations

Browsing Geo Locations in Google Map

Tools Browse Geolocation



Managing Documents

Loading Documents

Editing Documents

Edit

Exit Edit Mode



not

Renaming Documents

Rename

F2

Adding Documents



Deleting Documents

Delete

Undo

Tools

Renumber Documents

Duplicating Documents

Tools Duplicate Document(s)

Renumbering all Documents

Renumber Documents

Tools Renumber Documents



User-defined Document Sort Order

Name

Renumber Documents Tools



Project Management

Opening a Project

Welcome Screen

File > Open

Saving a Project

Save File > Save

Where Does ATLAS.ti Store Project Data?

About ATLAS.ti Libraries

Project

Export.

Renaming a Project

Rename Project

Deleting a Project



Delete Project

Password Protection

File > Info

Set Password



ATLAS.ti Project Data is Saved to a Library

Working with the ATLAS.ti Library

Important to know

Changing the Library Location

Options

Application Preferences > ATLAS.ti Library location > Switch Library



Moving the Library to a Different Location:

Creating a New Library:

Open an existing library:



Next

open an existing library:

move the library:

create a new empty library:

A note from the Help Desk:



Creating a Project Backup

export

ATLAS.ti Project Cloud

project bundle file

transfer projects

Project Transfer

Exporting a Project

File > Export



Project Bundle

Exporting partial bundle files

project name (user name YYYY-MM-DD)

Save

Project Management.





Exporting a partial bundle if your project
contains multimedia files

Project Bundle



Project Transfer

project bundle file

File > Export

Creating Partial Bundle Files



Project Bundle

project name (user name YYYY-MM-DD)

Save

Project Management.



Creating a Project Snapshot

Project Merge

Inter-coder

Agreement

(Snapshot YYYY-MM-DD hh:min:sec)

File > Snapshot

Create

Snapshot



Where Does ATLAS.ti Store Project Data?

Working with the ATLAS.ti Library.

Default Locations for Files and Text Analysis Models

Options

Application Preferences ATLAS.ti Default File

Location



Working With Groups

gender::female location::urban family

status::single

Exploring Coded Data

smart group

global filter

Quotation Manager

Application of Document Groups

Video Tutorial: Organizing documents and document groups

https://youtu.be/IWklmEGiIKs


Code Document

Table

Code Co-occurrence Analysis



Networks



Application of Code Groups



Code Document Table

building a coding system



Application of Memo Groups

Memos and Comments

Groups as Filters

X

any



all



Creating and Renaming Groups

Creating Groups in a Manager

Documents

Home

Create



New Group

Create

Creating Groups in the Project Explorer

New Group



Creating Groups in a Group Manager

Home

Group Manager

New Group



<



Creating Document Groups in the Query Tool

Creating Document Groups From Results

Renaming a Group

Rename

Rename





Removing Group Members / Deleting Groups

Removing Group Members

Project Explorer

Remove from Group

In Managers

Remove from Group

Filter Area in Managers



Remove from Group

Removing Group Members in the Group Manager

Home

Group Manager

>

Deleting Groups

Delete



Importing & Exporting Document Groups

Document Group Table

attribute name::attribute label or

value



Exporting Document Groups to Excel

Import & Export Document

Groups up

Save

Importing Document Groups from Excel



Document
Name

#gender
#age
group

likes
chocolate

#favorite drink

Import Document Groups Table

Import & Export Document

Groups down



Open



The ATLAS.ti Quotation Level

Working with Quotations

Code Document Table Code Co-occurrence Table

what you can do with quotations

instead to build a well-rounded

code system



Creating Quotations in Text Documents

Coding Data

Create Free

Quotation



Quotation ID

Changing the Chronological Order of Quotations

Renumber Quotations



Adding Quotation Names

Building a Code

System

Working with Multimedia Data

Rename.



Resize a Quotation



Creating Quotations in PDF Documents

Text selection

Selecting a graphical element:

Creating Graphic Quotations



Create

Free Quotation

Creating Multimedia Quotations

Creating Image Quotations



Creating Quotations in Image Documents

Create Free Quotation





Creating Quotations in PDF Documents

Text selection

Selecting a graphical element:

Creating Graphic Quotations

Create

Free Quotation





Working with Multimedia Data

Creating Multimedia Quotations

Project Preferences Automatically create new quotation on

selection

Create Quotation



Creating Multimedia Quotations while Listening / Watching

Mark Position Create

Quotation

Using the Ribbon Buttons

Mark Position

Create Quotation

Using Short-Cut Keys

To mark the start position:

To create a quotation:



Coding Multimedia Quotations

Apply Codes.

Coding Data

Activating and Playing Multimedia Quotations

In the Margin Area

play

From other Places



Working with

Hyperlinks

Adjusting the Size of Multimedia Quotations

Renaming a Multimedia Quotation

Rename

Making Use of Quotation Name and Comment for Analytical Purposes

Example Reports

Capturing Snapshots of Video Frames as Image Documents

Capture Video Frame.

Creating

Quotations im Images



Working with Quotations

Video Tutorial: Working with quotations

Making Use of the Quotation Names and Comments for
Analytical Purposes

Working with Tabs and Tab Groups

Rename

F2

https://youtu.be/luGhMy91LmY






CAQDAS and

Grounded Theory Analysis Grounded Theory Analysis and CAQDAS: A Happy

Pairing or Remodeling GT to QDA

Example Reports

Reviewing Coded Quotations and Modify Coding

Quotation Reader

https://www.mmg.mpg.de/61762/wp-16-07
https://www.mmg.mpg.de/61762/wp-16-07
https://methods.sagepub.com/book/the-sage-handbook-of-grounded-theory-2e/i2370.xml
https://methods.sagepub.com/book/the-sage-handbook-of-grounded-theory-2e/i2370.xml


Query tool Code Document Table Code Co-occurrence Table



Quotation Reader

Displaying Quotations in Context

Quotation Manager

Quotation

Reader

Working With Networks

Project Search

Deleting Quotations

Delete



Referencing Quotations

Changing the Chronological Order of Quotations

Renumber Quotations





Coding Data - Basic Concepts

“Coding means that we attach labels to 'segments of data' that depict what each segment is

about. Through coding, we raise analytic questions about our data from […]. Coding distills

data, sorts them, and gives us an analytic handle for making comparisons with other

segments of data”

“Coding is the strategy that moves data from diffuse and messy text to organized ideas

about what is going on”

"Coding is a core function in ATLAS.ti that lets you “tell” the software where the interesting

things are in your data. ... the main goal of categorizing your data is to tag things to define or

organize them. In the process of categorization, we compare data segments and look for

similarities. All similar elements can be grouped under the same name. By naming something,

we conceptualize and frame it at the same time"

Independent Code / Category Code / Subcode

independent codes



Independent code:

Free code:

Category Code:

inter-code agreement analysis



Subcode:

How to build a code system

Folder:

How Groundedness is Counted

Independent Code:

Category Code:



inter-code agreement analysis

positive effects

Subcode:

life is richer

Folder:

Experience of

Parenthood

How Density is Counted

code density

networks



Creating and Applying Codes

Video Tutorial: How to code data

Creating New Codes without Coding

Coding Data - Basic Concepts

Importing A List Of Codes

Home New Entities

New Code(s) Ctrl+K

Code Manager.

New Codes

Coding with a New Code

Apply Codes Ctrl+J

https://youtu.be/SivD3Uwf6Ng


Working With Multimedia

Data Working With Geo Docs

Code In-Vivo



Working with

Codes > Modifying the length of a coded segment

Code in Vivo

"Over-dependence on in-vivo codes ... 'can limit your ability to transcend to more conceptual

and theoretical levels of analysis and insight' (Saldana, 2009:77). Where they are descriptive

and unique to one person, the coder needs to move on from them quite quickly to generate a

more analytical code."

Display of Coded Data Segments in the Margin Area



Applying Existing Codes

Coding Dialogue Drag & Drop

Using the Coding Dialogue

Apply Codes

Drag-and-Drop Coding

Project Explorer

Code Browser

Code Manager

Drag & Drop Coding from the Code Browser

Home Codes



Working

With Networks

Drag & Drop Coding from the Code Manager

Working With Docked And Floated Windows

Quick Coding



Quick Coding

Ctrl+L

Document Ribbon when Coding

Create Free Quotation

Apply Codes:

Code In vivo:

Quick Coding:

Search & Code: Search & Code

Focus Group Coding: Focus Group Coding

AI Coding: AI Coding

Rename:

Delete:

Unlink:

Reverse Link:

Relation:

Comment:



Word Cloud:

Word List:

Concepts: Concept Search

Search Document:

Edit:

Print:

Printer:

Orientation:

Margin space:

Pages:



print with margin

Keyboard Shortcuts For Coding

Coding Short-Cut

More Drag-And-Drop Options



Writing Code Comments

Edit Comment



Edit Comment



Working with Codes

Modifying the Length of a Coded Segment

Removing a Coding

In the Margin Area

Unlink



In the Coding Dialogue

Applied Codes

Replacing a Code via Drag & Drop

Adding, Changing and Removing Code Color

Via the ribbon

Change Color

Change Color Remove color

Further Options in Networks.



Via the context menu

Change Color

Importing code lists



Renaming a Code

Rename

Rename

F2

Deleting One or Multiple Code(s)

Delete

About Renaming, Deleting and Unlinking Codes

applied

codings



global

Duplicating a Code

Duplicate Code(s)

Further Options in Networks.

Writing Code Comments



Edit Comment

Edit Comment





Retrieving Coded Data

Video Tutorial: Retrieving coded data

From the Project Explorer, Code Manager or Code Browser

Quotation Reader

Dock to Navigation Area

https://youtu.be/bDUg8pL_H6k


Simple Retrieval in the Margin Area

Simple Boolean Queries in The Quotation Manager



Search Code

Show

quotations coded with of ANY of the codes.....

any

ANY ALL



ANY: any

ALL all

Report Excel Export

Creating Reports



Creating Categories and Subcodes

Video Tutorial: Building a code hierarchy

categories

and subcodes

"If you have a typical project of moderate complexity, it should require no more than 10 top-

level [parent] categories" to cover the topic [...]. Furthermore, most code systems do not go

more than two or three levels deep. If they do, it is likely that the categories being used are

no longer true subcategories of the higher-order categories they are under; and, on a

practical level, it becomes inconvenient for the coder to remember, locate, and effectively

use them"

How to build a code system

folders

https://youtu.be/fEJD3SNtmBU


Creating Categories with Subcodes

free

Moving Codes under a Free Code

Build Code Hierarchy





Creating a Category via Splitting

Split into Subcodes

Add Codes

Add

Undecided



Mutually exclusive:

Mutually Exclusive

Requirements for Coding

Split Code.

Creating category and subcodes in the coding dialog

Apply Codes

Adding a category with subcode



Adding a new subcode to an already existing category

Easy coding with subcodes of a category



How to move subcodes out of a category



Organizing Codes in Folders

How to build an effective code system



How to create folders

New Folder

New

Folder with Selection



How to move items between folders or out of a folder



Exploring Coded Data

Exploring Data

Word Cloud Word List

Word Cloud Word List



Parts of Speech

Noun

Pronoun



Verb

Adjective

Adverb

Preposition

Conjunction

Articles and Determiners



Interjection

Open and Closed Word Classes

The 9 Parts of Speech: Definitions and Examples

https://www.thoughtco.com/part-of-speech-english-grammar-1691590


Exploring Text Data



Merging Codes

Video Tutorial:

Merge code ... into ...





Merge Codes

Merge

Merge Codes



Networks: Further Options



Splitting a Code

"Inevitably, not all codes you produce will continue to prove useful. Some will be too general,

others too specific to one or two segments of data (see Merging Codes). With the exception

of contextual codes, a category that is so broad or so vaguely defined that it codes a very

large number of passages or very lengthy passages is less likely to be useful in analysis"

Splitting a code into independent codes

Split

Code

Split



New Codes

Create



Split Code

Options

Copy Comments:

Copy links:

Mutually exclusive:

Mutually Exclusive Coding

Mutually Exclusive

Requirements for Coding



Splitting a code into a category and subcodes

Split into Subcodes

New Codes

Create

Undecided



Mutually exclusive:

Mutually Exclusive

Requirements for Coding

Split Code.



Display of Codes in the Project Explorer and
Code Browser

Home Codes

inter-code agreement analysis

View Options the Code Manager

View Modes:

Code Cloud

Cloud



Code List as Bar Chart

Bar Chart



Analysing Code Distributions



Display Code List as Code Cloud or Bar Chart

Code Cloud

Views Cloud

Code List as Bar Chart

Bar Chart



Printing the Code-Cloud or the Bar Chart View

Image Codes



Working With Code Groups

Code Manager Home

Codes

Create





Working With Groups

video

https://www.youtube.com/watch?v=Pn1q30S8PUc&list=PLs_YczcegWF5t4CJWhL9N1wGdIM-qekm0&index=11


Importing and Exporting a List of Codes

Exporting the List of Codes

Universal Data Exchange

Import & Export Export Codebook /

Export to Excel

Importing the List of Codes

Report

Examples

inductive coding



Import & Export Codebook

Import from Excel

Import





Building a Code System

How to Begin Building a Code System

merged split



Further Data Analysis



document groups





Characteristics of a well-structured code list

Code Co-occurrence Table

Good Practice Tips

The Role of Code Groups in Building a Code System



Moving on

code co-occurrence table code document table query tool networks

memos

reading the data resulting from a query

Literature

Qualitative Data Analysis: Practical Strategies.

Analysing Qualitative Data: Systematic Approaches.

Qualitative Research for education: An introduction to theory

and methods (2nd ed.).

Constructing Grounded Theory: A Practical Guide Through

Qualitative Analysis.

Basics of Qualitative Research:

Techniques and Procedures for Developing Grounded Theory.

Modes of Thinking for Qualitative Data Analysis.

Qualitative Data Analysis with ATLAS.ti.

Analysing Qualitative Data.

Applied Thematic Analysis.

Applied Thematic Analysis.

Ethnography: Principles in Practice.

International Journal of Social Research Methodology



Qualitative Data Analysis.

Readme first: for a user’s guide to Qualitative Methods.

Handling qualitative data: A practical guide.

The Coding Manual for Qualitative Researchers.

The Ethnographic Interview.

Qualitative analysis for social scientists.

Qualitative

Sociology,



Creating a Codebook

Export Codebook

Excel Export

Example Outcome:





Quotation Reader

coding on



View Options

Apply Codes Apply Codes

Coding Date



View in Context

Go to Context



Rename Rename



Open Network

Open Network Working with

Networks.



Select All

Apply Codes

Writing Comments for Quotations

Edit Comment



Creating a Report

Excel here



Exploring Text Data

Word lists

Word clouds

Creating Word Lists Creating Word Clouds



Creating Word Clouds

Word Cloud

Word Cloud

Word Cloud

Word Cloud

Search & Code

Code Cloud

Working with Codes



Setting the Scope

search field

World Cloud Ribbon

Show Scope:

Spiral:

Typewriter:

Sorting:

Threshold:

Exclude:



Stop / Go Lists:

Image:

Filter

Ignore Case:

Infer base forms:

s

Parts of Speech



Filter Tab

Character Filter:

Reload

Context Menu Options

Remove from Word Cloud

stop list

Copy to Clipboard

Text Search

Search in Context Project Search





Creating Word Lists

Word List

Word List

Setting the Scope

Word List

Word List

Search & Code



Sorting Word Lists

Setting the Scope



search field



Word List Ribbon

Show Scope:

Show Details:

Show Percent:

Threshold:

Exclude:

Stop / Go Lists:

Excel:

Filter

Ignore Case:

Show Inflected Forms:

s

Parts of Speech



Filter Tab

Character Filter:

|"(){}[]<>/\#+-_%$&“”´&#96;@^‘„



Reload

Context Menu Options

Remove from List

stop list

Copy to Clipboard

Text Search

Search in Context Project Search



Stop and Go Lists

here



Stop and Go Lists

stop lists Stop words

Ranks NL.

Go List

Selecting a Stop List

Exclude

Importing a Stop List

https://www.ranks.nl/stopwords


Edit Import Lists



Open



Cleaning up a Word Cloud

remove add the words the stop list

Remove

Add to stop list.



Creating a New Stop or Go Lists

Edit



New List

name Stop List Go List

Create

New Word button



RegEx:

List Type.

Exporting a Stop or Go List



Export List

Save

Creating a User-Defined Stop or Go List in Excel



Type-Token Ratio

Type-Token Ratio = (number of types/number of tokens) * 100



Automatically Code Data

Search & Code

AI Coding

Find Concepts and Auto-code

Text search

Expert search

Named Entity Recognition (NER)

Sentiment Analysis



AI Coding

Search & Code Analyze

Quick Overview

EULA Privacy Policy

https://atlasti.com/legal/terms-conditions
https://atlasti.com/privacy


How to get the Best Out of AI Coding



AI Coding In Depth





Intentional AI Coding

Search & Code

Analyze

Quick Overview

EULA Privacy Policy

https://atlasti.com/legal/terms-conditions
https://atlasti.com/privacy


How to get the Best Out of Intentional AI Coding



AI Coding In Depth



AI Summaries

Search & Code Analyze

Quick Overview

EULA Privacy Policy

https://atlasti.com/legal/terms-conditions
https://atlasti.com/privacy




Text Search and Auto-Code

Video Tutorial: Text search and auto-code

Carrying out a text search

Search & Code Text Search

Continue

https://youtu.be/wAXfLsnKO-g




synonyms

AND

OR

inflected forms

Inflected forms:

Manage Models



Show Results

Quotation Reader

eye

Apply Codes plus

Coding Dialogue

Exact Match Search

exact match

emotion

emotion

emotion



emotion

Exact

Phrase Search

Exact Phrase Search

with



Expert Search with Regular Expressions (regex)

GREP

https://

regex101.com/

Carrying out a text search with Regex

Search & Code Expert Search

Continue

https://regex101.com/
https://regex101.com/


Show Results

Quotation Reader



eye

Apply Codes plus

Coding Dialogue

GREP Examples

GREP
Expression

Description

^



GREP
Expression

Description

$

.

+

*
ab*c

?
ba?

[]

[a-z] [0-9] [aeiou]

[0-9] [^0-9]

\b

\B

<

>

GREP Expression Description

\d [0-9]

\D

\s

\S

\w

\W

Character classes

Character
Class

Description

[:alnum:]

[:alpha:]

[:cntrl:]

[:digit:]

[:graph:]

[:lower:]

[:punct:]

[:space:]



Character
Class

Description

[:upper:]

[:xdigit:]

[[:digit:]]+

Examples of GREP Searches

man|woman (|wo)man

H(a|e)llo

H(a|e)+llo

the (angry|lazy|stupid) (man|woman) (walk|run|play|fight)ing with 

the gr(a|e)y dog



Named Entity Recognition (NER)

Video Tutorial: Named Entity Recognition

Search & Code Named Entity Recognition.

Continue.

paragraphs sentences

word

https://youtu.be/c6nEthlRsFo


Manage Models:

Manage Models

Continue

Reviewing Search Results



Autocode results

Category only

Category: Entity

Show Results



Quotation Reader

eye

plus

Apply Proposed Codes Apply All

Codes



Coding Dialogue



The Search Engine Behind NER

here.

here

here

https://spacy.io/
https://spacy.io/api
https://spacy.io/models


Sentiment Analysis

Video Tutorial: Sentiment Analysis

Application Examples

Carrying out a Sentiment Analysis

Search & Code Sentiment

Analysis

Continue

https://youtu.be/8ZnCro7LhaE




Manage Models:

Manage Models

Show Results

Quotation Reader

eye

plus



Coding Dialogue

The Search Engine Behind the Sentiment Analysis

here.

here

https://spacy.io/
https://spacy.io/api


here

https://spacy.io/models


Find Concepts and Auto-Code

Video Tutorial: Concept search

What makes a concept?

Search & Code Concepts

https://youtu.be/BUHvchS2c8g


Concepts

List



Apply Proposed Codes



Opinion Mining

Search & Code Opinion Mining

Opinion Mining



Apply Proposed Codes



Analyzing Focus Groups

Quotation Level Hyperlinks

focus

group analysis

Guidelines for Preparing Focus Group Data

https://www.cambridge.org/core/services/aop-cambridge-core/content/view/S0029665104000874
https://www.cambridge.org/core/services/aop-cambridge-core/content/view/S0029665104000874


Guidelines for Preparing Focus Group Data

"for example:....."



Custom Pattern

Regular Expressions (GREP)



Example transcripts

Example A (pattern 1)

Alex:

Tom:

Deb:

Example B (pattern 1)

Alex:

Tom:

Deb:

Example C (pattern 1)

Alex: male: age group 1: high school:

Tom: male: age group 2: high school:



Deb: female: age group 2: some college:

Example D (pattern 2)

@Alex:

@Tom:

@Deb:

pattern 2



Recommendation



Auto Coding Focus Group Speakers

Focus

Group Coding

Focus Group

Coding

Preparing Focus

Group Data



Next

Code



after



Multimedia Data (Audio & Video)

Adding Multimedia Documents to a Project

Home

Add Documents button Add Linked Video/Audio.

Repair Link Tools

Tab



Display of Multimedia Documents

Audio wave:

Preview images:



Playhead:

Document preview:

Zoom:

Zooming the Timeline

Media Controls

Stop:

Skip to previous mark:

Skip backward:

Play / Pause

Skip to previous mark:

Skip forward:

Volume:



Multimedia Toolbar

Capture Snapshot:

Media Controls:

Volume:

Playback Rate:



Mark Position: Working with Multimedia Files

Create Quotation:

Working with Multimedia Files



Handling Multimedia Data

Zooming the Timeline

Media Controls

Stop:

Skip to previous mark:

Skip backward:

Play / Pause

Skip to previous mark:

Skip forward:

Volume:



Multimedia View Options

View tab

Position of the timeline:

Audio waveform:

Auto-scroll:

Use Arrow Keys to Navigate

right and left arrow keys



right and left arrow keys + Ctrl

Keyboard Shortcuts

Action Keyboard Shortcut



Working with Multimedia Data

Creating Multimedia Quotations

Project Preferences Automatically create new quotation on

selection

Create Quotation



Creating Multimedia Quotations while Listening / Watching

Mark Position Create

Quotation

Using the Ribbon Buttons

Mark Position

Create Quotation

Using Short-Cut Keys

To mark the start position:

To create a quotation:



Coding Multimedia Quotations

Apply Codes.

Coding Data

Activating and Playing Multimedia Quotations

In the Margin Area

play

From other Places



Working with

Hyperlinks

Adjusting the Size of Multimedia Quotations

Renaming a Multimedia Quotation

Rename

Making Use of Quotation Name and Comment for Analytical Purposes

Example Reports

Capturing Snapshots of Video Frames as Image Documents

Capture Video Frame.

Creating

Quotations im Images



Multimedia Preferences

File > Options

Autopreview

Autopreview

autopreview for documents

autopreview for quotations

autopreview for hyperlinks

Preferences for Creating Quotations



The Margin Area

Margin Display Options



Margin Drag & Drop

Linking

Creating Hyperlinks

Replacing

Copying

CTRL-key



Print with Margin

Print

Printer:

Orientation:

Margin space:

Pages:



print with margin



Memos and Comments

Video Tutorial: Using memos at project begin

Memos

"Memos and diagrams are more than just repositories of thoughts. They are working and

living documents. When an analyst sits down to write a memo or do a diagram, a certain

degree of analysis occurs. The very act of writing memos and doing diagrams forces the

analyst to think about the data. And it is in thinking that analysis occurs"

"Writing is thinking. It is natural to believe that you need to be clear in your mind what you

are trying to express first before you can write it down. However, most of the time, the

opposite is true. You may think you have a clear idea, but it is only when you write it down

that you can be certain that you do (or sadly, sometimes, that you do not)"

report writing

Theory-building

Typical Usage of Memos

project description

research questions

research diary

to do list

bulletin board

literature

analysis

https://youtu.be/Fn0DO0QKExk


Using Memos as

Document 

Differences between Memos and Comments

Quotation comment

Code comment



Memos



Typical Usage of Comments

Project comment

Document comment

Quotation Comment



Code Comment

Memo Comment

Network Comment

Link Comment

Difference between Memos and Codes

Working with Quotations

References



Working with Comments and Memos

Writing a Comment

Entity Manager

Save

Edit Comment

Creating Memos

Home Memo Manager

Home

New Entities Free Memo

Create

Interface Navigation

Memo Manager

Create Free Memo

Create

Save



Changing the Memo Type

type

commentary memo theory

memo

Set Type

Set Type

Opening an Existing Memo

Linking Memos

Linking Nodes



Linking Memos to Quotations

margin area

result

list

Quotation Manager

network Linking Nodes

Reviewing Quotations Linked to a Memo

Ctrl key + double-

click

Linking Memos to Codes

the memo branch

the code branch

Memo Manager Code Manager



network Linking Nodes

Linking Memos to Memos

Project Explorer

Memo Manager

network Linking Nodes

Converting a Memo into a Document

Convert to Document

Convert to

Document



Hyperlinks

Representing the Rhetoric of Data

hypertext

World Wide Web

What Codes Can't Do

code & retrieve paradigm

Manager for Links Analytic Functions of Networks

equivalence



Mapping Hyperlinks in Networks

named About Relations

Networks



Creating Hyperlinks

Creating New

Relations

Linking Nodes

Terminology

source

target

link source link target

relation

Display of Hyperlinks

In the Margin Area

In the Quotation Manager

Symbol Explanation



Symbol Explanation

Creating Hyperlinks in a Document

Create Link Source

Create Link Target



Defining New

Hyperlink Relations

Go to Quotation



Creating Hyperlinks in the Quotation Manager

Creating Hyperlinks in the Margin Area

Creating Hyperlinks across Documents

Working With Tabs And Tab Groups 



Working with Hyperlinks

Traversing Hyperlinks

Go to Quotation

Modifying Hyperlinks

In the Margin Area

Unlink,

Reverse

In the Hyperlink Manager

Home Links

Hyperlinks

Cut Flip Change Relation



Links Manager.

Modifying Hyperlinks in the Network Editor

Open Network

Ad-

hoc networks.

Flip Link Cut Link Change Relation

Linking Nodes.

Editing Hyperlink Comments

A B

Editing a Hyperlink Comment in the Margin Area

Edit Hyperlink

Comment

Editing a Hyperlink Comment in the Hyperlink Manager

Edit Comment

Editor comment



Editing a Hyperlink Comment in a Network

Open Network

Ad-hoc networks

Edit Comment.

Creating New Relations for Hyperlinks

Creating New Relations



Further Data Analysis

Simple Boolean Retrieval.

Retrieving Coded Data.



Analysing Code Distributions

Analysing Code

Distributions

Code-Document Table

Code Document Table.



Co-occurrence Analysis

Code Co-Occurrence Tools.



The Query Tool

The Query Tool.

Smart Codes

Working With

Smart Codes.



Smart Groups

Working With Smart Groups.

Global Filters

Applying Global Filters For Data Analysis.





Available Operators for Querying Data

Boolean operators

Proximity operators

Boolean Operators

Video Tutorial: Explaining Boolean Operators

binary operators

AND: ALL of the following are true

Example:

https://youtu.be/WlN3SwcZKkE


OR: ANY of the following are true

Example:

ONE OF: Exactly one of the following is true

Example:

NOT: None of the following are true

not

Example 2 in the section Building Complex Queries

Proximity Operators

Video Tutorial: Proximity Operators and Example Queries

https://youtu.be/g5vnIhF26-A


non commutative

Quotations enclosing quotations

Quotations being enclosed by quotations

Overlaps (quotation overlapping at start)

Overlapped by (quotations overlapping at the end)

Co-Occurs

Non-commutativity of proximity operators

Non-commutativity







The Query Tool

Query Tool

Retrieving Coded Data

query

(Boolean, proximity or semantic operators)

Analyze Query Tool

available operators for querying data



How to Build a Query Using Boolean Operators

Video Tutorial Creating a Boolean OR query in the Query Tool

Children & Happiness sample projects part 1

Example 1

Analyze Query

Tool

Question

OR

Add

https://youtu.be/uvpILbn3Z2U
https://atlasti.com/sample-projects
https://atlasti.com/sample-projects




Inspecting the Results of a Query

Quotation Reader

burger menu Open in new window



status bar



Options of the Result Pane

Eye

Burger

Removing or Modifying a Query

Delete

Delete

Change Operator

Example 2

Question



OR

AND



Rotate Layout

Change

Operator



How to Build a Query using Proximity Operators

Video Tutorial: Proximity Operators and Example Queries

Children & Happiness sample projects part 1

Example 1

Analyze Query

Tool

Question

Co-occurs

https://youtu.be/g5vnIhF26-A
https://atlasti.com/sample-projects
https://atlasti.com/sample-projects


Add

status bar

Co-occurs

Swap



Delete



Example 2

Question

Encloses



Co-occurs

Rotate layout

Inspecting the Results of a Query

Quotation Reader

Options of the Result Pane

Eye



Burger

Removing a Query or an Argument

Delete

Delete



How to Build a Query using a Mix of Operators

Children & Happiness sample projects part 1

Boolean Queries Proximity Queries.

Example 1

AND

Co-occurs

https://atlasti.com/sample-projects/
https://atlasti.com/sample-projects/


Swap



Example 2

NOT

AND

Encloses





Restrict a Query to Sub Groups in your Data

Video Tutorial: Query Tool with Scope

Opening the Scope Tool

Edit Scope

Example Boolean Query

Changing the Scope

Delete

Closing the Scope Tool

Edit Scope

https://youtu.be/Qz5lPOh94yA


Storing the Results of a Query

here

Save Smart Code

Query Tool

Create

Working With Smart Codes 

Research question 3: Positive & negative views on parenting



Creating Document Groups from Results

Example Boolean Query

New Document Group

Create Document

Group



Query Tool Reports

Excel Report

'burger menu'

Text Report

Report:

Creating Reports

List:

Quotation Level

List With Comments:

Full Content:

Content plus Comments:



Code-Document Table

Code-Document Table

frequency count

word count

Running an Analysis in the Code-Document Table

Home Analyze Code Document

Table

How to make selections

Ctrl/

Cmd or Shift-key space bar

Check Selected.



How to read the table

Left column

Top row

Table cells

number of

codings

Quotation Reader

Code-Document Table Ribbon

Colors:



Row Totals:

Column Totals:

Normalize:

Code

Document Table: Normalizing Data

Binarize:

Absolute Frequencies: the number of codings

Relative Frequencies:

Column Rel.-Frequencies:

Row Rel.-Frequencies:



Table Rel.-Frequencies:

Count Codings:

Count Words:

Compress:

Codes as Rows:

Codes as Columns:

Details:

Export:

Sankey: Visualizing the Code-

Document Table

Bar Chart: Visualizing the Code-

Document Table

Show Lists:

Show Table

Show Diagram:



Refresh:

Refresh

View Tab

Show Lists:

Refresh:

Refresh

Auto size Columns:

Freeze first Column:

Set Column Size:



Code-Document Table: Relative Frequencies

Data Normalization.

Across Group Comparison: Row Relative Frequencies

Code-Document Table showing an example of an across-group-comparison

here

https://atlasti.com/sample-projects


Within Group Comparisons: Column Relative Frequencies

Children & Happiness

Total Relative Frequencies

Example application of total relative frequencies

https://atlasti.com/sample-projects




Code-Document Table: Normalization

memo

Relative Frequencies



Binarize the Results of a Code-Document Table

Binarize

black dots

totals

export





Visualizing the Code-Document Table

Sankey Diagram

Video tutorial: Sankey Diagrams in ATLAS.ti Windows

Further Reading

Using sankey diagrams to tell a story with data

Visualizing customer journey with sankey diagram

A sankey diagram says more than a 1000 pie charts

What, Why and How of sankey diagrams

Using colors effectively in sankey diagrams

Sankey

https://youtu.be/-3N86QAaQ0s
https://learninginnovation.duke.edu/blog/2015/11/using-sankey-diagrams-tell-story-data/
https://ppcexpo.com/blog/visualizing-customer-journey-with-sankey-diagram
https://www.sankey-diagrams.com/
https://towardsdatascience.com/the-what-why-and-how-of-sankey-diagrams-430cbd4980b5
https://www.displayr.com/using-colors-effectively-in-sankey-diagrams/


nodes edges

Edge:



Layout

Interactivity

Removing edges

Delete



Sankey Diagram Ribbon

Fit to Window:

Fit-to

Window

Refresh Layout:

Auto Layout:

Respect Node Placement:

Respect Node Placement

Respect Node Placement

Shortcut:

Rotate Diagram:

Shortcut:

Display Icons:

Link Color Mode:



Print Diagram:

Miscellaneous

Bar Chart

Bar Chart







Code Co-Occurrence Tools

co-occurrence tools

co-occur

available operators



The Code Co-Occurrence Table

Analyze Co-Oc Table

space bar

Check Selected



global filter

How to Read the Table

First column / first row

Quotation Reader

Code Co-Occurrence Table Ribbon

Show count:

Show Coefficient:

C-Coefficient



Cluster quotations:

Use AND operator:

Proximity

Operators

Rows => Columns:

Compress:

Auto Size Columns:

Freeze first column:

Set Column Size:

Details:

Export:

Show Count

Show Coefficient

Table:

Sankey: co-occurrence visualization

Bar Chart: co-occurrence

visualization

Force-Directed Graph:

co-occurrence visualization

Show Lists:

Refresh:

Refresh



Code Co-occurrence Coefficient

range

calculation

surveys

Distortion due to unequal frequencies

a yellow

dot appears



Out of Range

redundant coding

All cells displaying an out-of-range number (> 1) show a red dot in the top right corner.

Finding Redundant Codings 

Summary of Color Indicators

Yellow dot:

Red dot:



Orange dot:



Visualizing the Code Co-Occurrence Table

Table

Sankey Diagram



nodes edges

Edge:

Layout



Interactivity

Removing edges

Delete

Sankey Diagram Ribbon

Fit to Window:



Fit-to

Window

Refresh Layout:

Auto Layout:

Respect Node Placement:

Respect Node Placement

Respect Node Placement

Shortcut:

Rotate Diagram:

Shortcut:

Display Icons:

Link Color Mode:



Print Diagram:

Miscellaneous

Bar Chart

Bar Chart





Smart and Snapshot Entities

smart entity

smart

snapshot entity



What are Smart Codes?

Smart Codes

cannot

not

creating a snapshot code

What you cannot do with Smart Codes

Coding:

Merging:



Working With Smart Codes

Creating an ORed Smart Code in the Code Manager

Create Smart Code

merging

code the speakers in a focus group transcript,



Creating a Smart Code in the Quotation Manager

Available Operators for Querying Data > Boolean

Operators

AND

ALL

OR

ANY

Smart Code

Create Smart Code

Create.



Creating a Smart Code in the Query Tool

build a query

Save Smart Code

Create

Editing a Smart Code

Edit Smart Code

How to build a

query.

snapshot code



What are Smart Groups

Smart Groups

smart document groups

gender location

Available Operators for Querying Data

> Boolean Operators

Applying Global

Filters For Data Analysis network and display

document group - code connections



Working With Smart Groups

Applying Global

Filters For Data Analysis network and display

document group - code connections

Creating a Smart Group

New Smart Group

Create

Editing a Smart Group

Home

[ ] Groups

Edit Smart Group

query tool

OR:

AND:

ONE OF (Exactly one of the following is true):

Evaluation of a computer game

one of



NOT (None of the following are true):

children and happiness document groups that have

been created based on the issues coded in the data

how to build a query



What are Snapshot Codes and Groups?

Snapshot Codes

snapshot code

snapshot code smart code

turn all code groups into smart codes

using the query tool

Building a Code System

Snapshot Groups

snapshot group

Application:



Creating Snapshots

Creating a Snapshot Code

Create

Snapshot

Creating a Snapshot Group

Home

Create Snapshot



Working with Global Filters

To set a global filter

Set Global Filter







Activating / Deactivating Global Filters

Changing a Global Filter

Removing a Global Filter

x

Clear Global Filter

Documents as Global Filter

retrieving quotations by double-clicking on a code quotation

reader

Code-Document Table



Code Co-occurrence Analysis

network

Filtering the code distribution across documents in the Document
Manager

code distribution across documents





Global filters in networks

networks Add

Neighbors Add Co-occurring Codes

network

Memo Groups as Global Filter

memo manager

selection lists

margin area

network

Network Groups as Global Filter

network manager

selection lists

margin area

network



Creating a Global Filter

creating a group



Analysing Code Distributions

Code Distribution across Documents



Code Distribution by Documents







Setting a Global Filter

Set Global Filter

Display Of Global Filters

Activating / Deactivating Global Filters

Changing a Global Filter

Removing a Global Filter

x

Clear Global Filter



Removing / Changing / Activating / Deactivating
a Global Filter

Removing a Global Filter

x

Clear Global Filter

Changing a Global Filter

set it as global filter.

Activating or Deactivating Global Filters



Global Filters in the Code Co-occurrence Table



Global Filters in the Code Document Table



ATLAS.ti Networks

Video utorial: Visualizations in Building the Understanding

network

nodes links

https://youtu.be/P6AlJxTaXvI


Nodes And Links

network

Directed and Non-Directed Links

source node

target node

Linking Nodes

First-Class Links

Working With Hyperlinks



Second-Class Links

Why Groups Cannot be Linked

Building a Code System

Working with document groups

Working with Smart Groups



Relations

named links

Link vs. Relation

use

instances



ATLAS.ti Default Relations

Relation Name
short
name

symbolic
name

width color property

search routines automatic layout

property

preferred layout direction ad hoc network

Formal Properties - Some Definitions

Symmetric Relationship

Examples:

is married to

is a fully biological sibling of

is a homophone of

QDA Examples:

is associated with

is related to



is associated with

Asymmetric Relations

Examples:

is a child of

QDA Examples:

results in

motivates results in



Relation Manager

Working With Networks

Links Home

Usage:

Style:

Layout:

Short:



Symbol:

Formal Property: About Relations

Relation Manager Ribbon

New Relation:

Duplicate Relation(s):

Rename Relation:

Delete Relation(s):

Line Color:

Line Width:

Line Style:

Layout Direction:

Formal Property:

About Relation

Filter:

Excel Export:

View Tab

Entity Manager



The Network Editor

is associated with

is associated with



Node Types

Codes as Nodes

Memos as Nodes

Documents as Nodes

add code

neighbors



Quotations As Nodes

Nodes and Link

Groups as Nodes

Network as Nodes



Network View Options

View

Overview:

Fit to Window:

Grid:

Snap:

Link Label:

Creating & Modifying Relations

Node Styles:

Layout/Style

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Networks/NetworksCreatingNewRelations.html


Style

Comments:

Code-Document Connections:

Preview:

Preview

Frequencies:

Groundedness:

Density:

Show Node Icons:



Network Editor - Layout And Routing Options

Network

Tab View Tab

Grid Snap

Layout Options

Perpendicular Layout:

Orthogonal Tree Layout:

Circular Layout:



Circular Single Cycle Layout:

Organic Layout:

Radial Layout:

Hierarchical Layout:

Hierarchical Layout (Top-Bottom):

Hierarchical Layout (Bottom-Top):

Hierarchical Layout (Left-Right):

Hierarchical Layout (Right-Left):

Tree Layout:

Random Layout:



Routing

Orthogonal Routing:

Poly Line Edge Routing:

Organic Routing:

Straight Routing:

export



Basic Network Procedures

Creating a New Network

New Entities New

Networks

Create

Networks New

Network

Adding Nodes to a Network

Add Nodes

Adding Nodes Using the Selection List

Nodes Add Nodes



Adding Nodes Using the Selection List

Nodes Add Nodes



Add

Adding Nodes via Drag & Drop

Selecting Nodes

Selecting a Single Node



Selecting Multiple Nodes

Method 1

Ctrl

Method 2



Opening Ad-hoc Networks

Adding Nodes To Network Adding

Neighbors

Show in Network

Layout And Routing.

file:///var/folders/4b/gbys909n5xx42zd9fw52wtz00000gn/T/build_tools_martinwinter/Local.DevBuildb0/PDF/Networks/NetworksCreatingNetworksAddingNodes.html


Save



Linking Nodes and Entities

Linking via Drag & Drop



New Relation Type create a new

relation

Linking Two Nodes Using the Ribbon Icon

Link

Density



Linking Three or More Nodes

Basis Network

Procedures > Selecting Nodes

Link

Editing a Link

Open Network:

Edit Comment:

Flip Link: transitive or asymmetric

link.

Cut Link:

Change Relation:



cut link



Cutting Multiple Links

Cut Links

Linking Codes to Codes, Quotations to Quotations, Memos to
Memos in Managers and Browsers

New Relation Type create a new relation.



Linking Entities of Different Types



Creating & Modifying Relations

About Relations

Creating New Relations

Home Links

Relations Relation Manager



Code-

Code Relations Hyperlink Relations

New Relation

Create

About Relations

Editing Existing Relations

Code-

Code Relations Hyperlink Relations



Analytic Functions in Networks

Applying Global Filters

Add Neighbors

add neighbors

Code Document Table

hyperlinks

How to add neighbors

Add Neighbors

Nodes



Show Code-Document Connections

View tab

all common

Application: Comparing Cases

Show Code-Document

Connections View options



Applying global Filters

Add Co-occurring Codes

add co-occurring codes Code Co-occurrence Tools

overlap

are overlapped by

occur within

enclose

code the same

Available Operators > Proximity Operators

Add Co-

occurring Codes Nodes



Applying Global Filters.



Exporting Networks

Saving a Network as Graphic File

Export Export Bitmap

Saving a Network in the Microsoft XPS format

Export XPS

Saving a Network in PDF format

Print



Network Editor - Further Options

Changing Code Color

Merge Codes

Nodes Merge



Duplicate Codes

Nodes

Duplicate Code(s)

Create Groups

New Group

Nodes

Create

Traversing Hyperlinks in Networks

Import Neighbors > Quotations.



Team Work

Working with ATLAS.ti Libraries

must not edit

Workflow

Master project Creating a New Project

adds documents

project

bundle file

import



project bundle file

merges

Transfer Projects

for project administrators

for team members

Important to Know

Adding Documents.

must not edit

Working with ATLAS.ti Libraries.



User Accounts

To check who is currently logged in:

Tool Manage Users.

Change the Current User

Tool Manage Users.



Set as Current User

Creating a new user account

Tools Manage Users

New User Create

Switch User

Switching user accounts

Tools Switch Users



Merging Users



Setting Up a Team Project

Work Flow

Tasks for

Team Members

Tasks of the Project Administrator

Creating and distributing the project

New Project

File > New > Create New Project.

Create.

Adding documents to a project.



Working with groups.

Importing A List Of Codes.

Save icon

File > Save

File > Export

Project Transfer

Distribute the project bundle file to all team members:

.atlproj



Team Project: Tasks for Team Members

must not edit

User Accounts

Import Project

File > New > Import Project

Rename the project



Import

File > Export > Project Bundle Project Transfer



Renaming Projects after Import

Rename Project



Merging Projects

Merge Project

identical

Identical Entities Explained

sunshine

sunshine

sunshine

sunshine (2)

merge Housekeeping

Groups are Additive



Entities with and without Comments



Keep

Override.

Handling of Deleted Entities



and



How to Merge

File > Merge

Merge Project Merge Project Bundle.



project name (Snapshot--date-time).

Merge

Merge



Keep

Override

Override Import



cannot

Undo



Housekeeping

Team Work



Housekeeping

Merging Duplicate Codes

Merge Codes

Merging Users

Tools Manage Users



Inter-coder Agreement (ICA)

Merging Projects

Why It Matters

"But being reliable (to use the adjective) beats being unreliable. If a

category is used in different ways, you will be unable to rely on it to bring you all the relevant data.

Hence, you may wish to ensure that you yourself are reliably interpreting a code the same way

across time, or that you can rely on your colleagues to use it in the same way"

"that the reading of textual data as well as of the research results is replicable

elsewhere, that researchers demonstrably agree on what they are talking about. Here, then,

reliability is the degree in which members of a designated community agree on the readings,

interpretations, responses to, or uses of given texts or data. [...] Researchers need to demonstrate

the trustworthiness of their data by measuring their reliability"



Prof. Klaus

Krippendorff Content Analysis: An

Introduction of Its Methodology Krippendorff's alpha coefficient

something

Literature

The Challenge of Intercoder Agreement in

Qualitative Inquiry.

https://www.asc.upenn.edu/people/faculty/klaus-krippendorff-phd
https://www.asc.upenn.edu/people/faculty/klaus-krippendorff-phd
https://books.google.nl/books/about/Content_Analysis.html?id=q657o3M3C8cC&redir_esc=y#:~:text=Since%20the%20publication%20of%20the,namely%2C%20the%20ongoing%20information%20revolution.
https://books.google.nl/books/about/Content_Analysis.html?id=q657o3M3C8cC&redir_esc=y#:~:text=Since%20the%20publication%20of%20the,namely%2C%20the%20ongoing%20information%20revolution.
https://en.wikipedia.org/wiki/Krippendorff%27s_alpha
https://www.researchgate.net/publication/228490436_The_challenge_of_intercoder_agreement_in_qualitative_inquiry
https://www.researchgate.net/publication/228490436_The_challenge_of_intercoder_agreement_in_qualitative_inquiry


Validity, trustworthiness and rigour: quality and the idea of qualitative

research.

https://pubmed.ncbi.nlm.nih.gov/16441535/
https://pubmed.ncbi.nlm.nih.gov/16441535/


ICA - Requirements For Coding

Coding Data

several independently working coders

semantic domains

Semantic Domains



mutually exclusive concepts code

multivalued

coding

Semantic domains are context dependent

Semantic domains need to be conceptually independent

Developing a

Code System.



Developing the Code System and Semantic Domains

Project Setup

exhaustiveness

Rules for Applying Codes

Mutual exclusiveness



Multi-Valued Coding

Code Co-Occurrence Tools

Instructions for Coders



Project Setup

double-check your username



How Agreement and Disagreement is Measured

what is measured is inter-coder agreement

quotation

Project Setup



Example Application

Why are many business instilling a DevOps culture into their organization?

https://arxiv.org/abs/2005.10388


Methods For Testing ICA

Percent Agreement

Example Coding of Two Coders

Segments 1 2 3 4 5 6 7 8 9 10



semantic domains.

Holsti Index

quotations

Cohen's Kappa

limitations

"It is quite puzzling why Cohen’s kappa has been so popular in spite of so much controversy

with it. Researchers started to raise issues with Cohen’s kappa more than three decades ago

(Kraemer, 1979; Brennan & Prediger, 1981; Maclure & Willett, 1987; Zwick, 1988; Feinstein &

Cicchetti, 1990; Cicchetti & Feinstein, 1990; Byrt, Bishop & Carlin, 1993). In a series of two

papers, Feinstein & Cicchetti (1990) and Cicchetti & Feinstein (1990) made the following two

paradoxes with Cohen’s kappa well-known: (1) A low kappa can occur at a high agreement;

and (2) Unbalanced marginal distributions produce higher values of kappa than more

balanced marginal distributions. While the two paradoxes are not mentioned in older

https://en.wikipedia.org/wiki/Cohen%27s_kappa


textbooks (e.g. Agresti, 2002), they are fully introduced as the limitations of kappa in a

recent graduate textbook (Oleckno, 2008). On top of the two well-known paradoxes

aforementioned, Zhao (2011) describes twelve additional paradoxes with kappa and suggests

that Cohen’s kappa is not a general measure for inter-rater reliability at all but a measure of

reliability under special conditions that are rarely held. Krippendorff (2004) suggests that

Cohen’s Kappa is not qualified as a reliability measure in reliability analysis since its definition

of chance agreement is derived from association measures because of its assumption of

raters’ independence. He argues that in reliability analysis raters should be interchangeable

rather than independent and that the definition of chance agreement should be derived from

estimated proportions as approximations of the true proportions in the population of

reliability data. Krippendorff (2004) mathematically demonstrates that kappa’s expected

disagreement is not a function of estimated proportions from sample data but a function of

two raters’ individual preferences for the two categories." (Xie, 2013).

Why Cohen's Kappa is not a good choice.

https://nces.ed.gov/FCSM/pdf/J4_Xie_2013FCSM.pdf
https://atlasti.com/2020/07/12/measuring-inter-coder-agreement-why-cohens-kappa-is-not-a-good-choice/#:~:text=Krippendorff%20(2004)%20suggests%20that%20Cohen's,its%20assumption%20of%20raters'%20independence.


Krippendorff's Family of Alpha Coefficients

Alpha binary

as well

global alpha binary

cu-alpha



Requirements for Coding

Cu-alpha

multivalued coding

Calculation of Krippendorff's Alpha

ICA

Appendix

https://atlasti.com/home/intercoder-agreement-with-atlas.ti-by-prof.-krippendorff.pdf
https://atlasti.com/home/intercoder-agreement-with-atlas.ti-by-prof.-krippendorff.pdf




Decision Rules

References

Beyond kappa: A review of interrater

agreement measures.

Agree or disagree? A demonstration of an alternative statistic to Cohen's kappa for

measuring the extent and reliability of agreement between observer.

https://pdfs.semanticscholar.org/7dc9/7e85652502ccfab37c549c671408ce94a94e.pdf
https://pdfs.semanticscholar.org/7dc9/7e85652502ccfab37c549c671408ce94a94e.pdf
https://nces.ed.gov/FCSM/pdf/J4_Xie_2013FCSM.pdf
https://nces.ed.gov/FCSM/pdf/J4_Xie_2013FCSM.pdf


Sample Size and Decision Rules

Sample size

Example:



More than two coders:

More than 10 sub-codes per domain:

Unequal distribution of codings within a domain

Acceptable Level of Reliability



Setting Up a Project for Inter-coder Agreement
Analysis

Team Work

Merging Projects

Instructions for the Principal Investigator (PI)

Requirements for Coding Master

Project

creating a project snapshot

Sample Size and

Decision Rules

Document Management



Option A

Delete

creates a project bundle file

Option B

Tools Remove codings

creates a project bundle file

Instructions for Coders



double-check your username

semantic domain

mutual exclusive coding

multivalued coding

Continues Workflow

Merging projects for ICA analysis

run the ICA analysis



Merging Projects For ICA Analysis

Analyze / Enable Intercoder Mode

File / Merge

Project Merge

codings

View Show

User.

coder icons



Running an Inter-coder Agreement Analysis

coding



Running an ICA Analysis

Analyze Inter-coder Agreement

Add Coder

Add Documents

Add Semantic Domain

semantic domain here.

Methods for Testing ICA.



Quotation Reader



Calculating an ICA Coefficient

Agreement Measure

Methods For Testing ICA





Tools

The Redundant Codings Analyzer

Project Search

redundant codings' analyzer

redundant codings' analyzer

project search



Project Search

Project Search tool

Regular

Expressions (GREP)

Tools Project Search

Use GREP

case-sensitive

Enter search icon

Searching in Selected Entities

Show None

Refining a Search

Search Text Search Result

Enter



Finding Redundant Codings

Find Redundant Codings Tools

& Support

Redundancy

Unlink from Left Quotation

Merge Quotations

Unlink from Right Quotation

Connectivity



Creating Reports

burger menu

predefined reports are available in the Query Tool

Code Document Table Code Co-Occurrence Table





Types of Reports

Reports

Creating Reports

Data Export

export all documents

SPSS

a statistical software like R, SAS,

etc.

Project Export

QDPX import.

Tables

Code Document Table Code Co-

Occurrence Table

Exports in PDF Format

document with margin networks

Project > Print.

Exports as Image Document

Sankey diagrams

https://www.qdasoftware.org/


Create Word / PDF Reports

Creating Report from the Code Manager



Create Report



Creating Reports from the Quotation Manager





Create Report

rtf PDF

Document Reports





Create Report



Memo Reports



Create Report





Creating Excel Reports

Quotation Report by Codes.

Report: All Quotations for a Code

Excel Export



Report Examples



Info Sheet for Excel Reports

Info Sheet in Excel



Example Reports

All quotations for one or multiple codes (Option 1)

Quotation Manager

Excel Export

ID

Quotation Name

Document

Quotation Content

Comment

Codes

Reference



Group by

Codes



All quotations for one or multiple codes (option 2)

Code Manager

Report





Report: Documents and their codes

Excel Report



Resulting report

Report: For multimedia data

Excel Report







Print Documents with Margin

Print

Printer:

Orientation:

Margin space:

Pages:



print with margin



Exporting Data

a SPSS syntax file

a Excel file for use in other statistical software like R, STATA, etc.

a project file in the QDPX universal data exchange format for importing your projects in

other QDA software

an export of all documents that have been added to a project



Exporting Documents

To export documents:

Tools Document

Export



Data Export For Further Statistical Analysis

syntax

cases

Scaled vs. Dichotomous Codes

dichotomous

one



SPSS syntax file

not



SPSS Syntax Export

variables

cases

Creating a Syntax File

Import & Export SPSS Job



Use separate file:

Specify the name of the data set.

Create a fresh data file during next run

Include quotation's author.

The value separator Naming

Convention For Scaled Codes

Create task section.

Create SAVE OUTFILE instruction.

Create

The Syntax File Explained

Yes (1)

No (0)

case (quotation)



Start and End Positions

Data
Type

SY (start) SX (start) EY (end) EX (end)

Creation Date

Variable Labels



Document Type Declaration.

Treatment of Code Groups



Scaled codes are ignored in the computation of code groups variables. Export for further

Statistical Analysis

Treatment of Document Groups



Generic Export for further Statistical Analysis

Import & Export

Statistical Data.

RStudio File/Import Data Set



QDPX - Universal Data & Project Exchange

We are very excited to see that - after fifteen years of ATLAS.ti being the only manufacturer

to steadfastly champion universal data exchange - other software makers are now coming

around to seeing the benefit of not holding users' data hostage any longer.

ATLAS.ti responded to the wishes of researchers early on by offering an open, application-

independent export format for universal use. This long-standing commitment to academic

openness and the free flow of ideas is now being recognized as an important value in itself.

I am convinced that being able to move projects seamlessly between different applications

will be of great benefit to the research community. We are extremely proud to have been

pioneers of this movement, and we are looking forward to the many advancements it will

bring! Thomas Muhr, March 18, 2019.

What is QDPX

Rotterdam Exchange Format Initiative (REFI)

https://atlasti.com/?page_id=15418&preview=true
https://www.qdasoftware.org/


Why is QDPX Great for You?

here.

https://www.qdasoftware.org/products-project-exchange/


Exporting a Project in QDPX Format

File / Export QDPX Project Bundle



Appendix

System Requirements

Language Settings

Service Packs & Patches - Live Update

Preference Settings

Get In Touch

Useful Resources:



Language Settings

Changing the Display Language

File > Options > Application

Preferences > Display Language

System Requirements

Hardware:

Operating systems:



Options

Application Preferences

Changing the Display Language

Switching Libraries.

Named Entity Recognition Sentiment

Analysis.

Project Preferences

lists and managers

lists and the Project Explorer

Managers

multimedia files

multimedia quotations





Service Packs & Patches - Live Update

File > Options > ATLAS.ti > Check for

Updates



Useful Resources

ATLAS.ti Welcome Screen

The ATLAS.ti Website

https://atlasti.com/

Getting Support

https://support.atlasti.com

Help > Online Resources / Contact Support

Video Tutorials

ATLAS.ti Video Tutorials

Sample Projects

website

https://atlasti.com/
https://support.atlasti.com/
https://atlasti.com/video-tutorials
https://atlasti.com/sample-projects


PDF Manuals

ATLAS.ti Full Manual and other documentations.

Research Blog

The ATLAS.ti Research Blog

contact us

Inter-coder Agreement in ATLAS.ti by Prof. Krippendorff

multi-valued

coding. an article written by Prof. Krippendorff

Publications

https://atlasti.com/manuals-docs/
https://atlasti.com/research-hub
mailto:training@atlasti.com
https://atlasti.com/home/intercoder-agreement-with-atlas.ti-by-prof.-krippendorff.pdf


Carrying out a computer-aided

thematic content analysis with ATLAS.ti. MMG Working Paper 18-0.

CAQDAS and Grounded Theory Analysis. Working Papers WP 16-07

Qualitative Social Network Analysis with

ATLAS.ti: Increasing power in a blackcommunity.

Making Thinking Visible with Atlas.ti: Computer Assisted Qualitative

Analysis as Textual Practices. Forum Qualitative Sozialforschung / Forum: Qualitative Social

Research, 9(2).

https://www.mmg.mpg.de/62142/WP_18-02_Friese-Soratto-Pires_AtlasTI.pdf
https://www.mmg.mpg.de/62142/WP_18-02_Friese-Soratto-Pires_AtlasTI.pdf
https://www.mmg.mpg.de/61773/WP_16-07_Friese-Theory-Analysis.pdf
https://depositonce.tu-berlin.de/handle/11303/5484
https://depositonce.tu-berlin.de/handle/11303/5484
https://doi.org/10.17169/fqs-9.2.420
https://doi.org/10.17169/fqs-9.2.420
https://doi.org/10.17169/fqs-9.2.420


Get In Touch

Reporting A Problem

Help tab Report Problem

description of the problem

valid email address

Sending Suggestions

Help tab Send Suggestions

Twitter

Facebook

LinkedIn

Instagram

YouTube channel

https://twitter.com/ATLASti
https://www.facebook.com/ATLAS.ti
https://www.linkedin.com/in/atlas-ti-gmbh-03249489/
https://www.instagram.com/atlas.ti_qdasoftware/
https://www.youtube.com/user/ATLASti01
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